
Creating and Using Nicknames
Creating and Using Nicknames
.i.Nicknames;When addressing messages, Eudora supports the use of nicknames in place of full 
user names.    A nickname (sometimes called an alias) is an easily remembered, shorter substitute 
for an actual E-mail address or group of addresses.    
Typically, nicknames are created for persons with whom one has repeated correspondence, and 
hence serve as a typing and reference shortcut.    Eudora allows nicknames to be used in place of 
proper E-mail addresses in the To:, Cc:, and Bcc: fields in the headers of outgoing messages.

To create, edit, or remove a nickname, select .i.Nicknames... command;Nicknames... from the 
Special menu.    The Nicknames window is then displayed.    This window is divided into three 
main fields.    The Nickname: field lists all your nicknames; the .i.Nicknames 
window:Address(es) box;Address(es): field displays a selected 
nickname’s .i.Nicknames:Expansion;expansion (the addresses that the nickname represents); and
the .i.Nicknames window:Notes box;Notes: field contains your private notes on a nickname.
 
 

                                                                                    The Nicknames window



Adding New Nicknames
.i.Nicknames window:Adding nicknames;To add a new nickname, click on the .i.Nicknames 
window:New button;New button.    The new nickname dialog is displayed prompting you for the 
name of the new nickname.
 
 

                                                                                    New nickname dialog

Type the name of the new nickname.    If you want this nickname to show up on the .i.Quick 
Recipient list:Adding new nickname to;Quick Recipient list under the Message menu (see the 
“Using the Quick Recipient List” section), click on the .i.Put it on the recipient list button;Put it 
on the recipient list option.    Then, click OK.

The new nickname is displayed in the Nicknames: field of the Nicknames window, and the 
insertion point is placed in the Address(es): field.    Type the complete E-mail address of the 
person to be represented by the nickname.
 
 



                                                          Entering an address for a nickname

.i.Nicknames window:Adding names to nicknames;If you’d like to add someone’s proper name 
to the address that you specify, just put it in parentheses after the E-mail address.

Note:
Be aware that the proper name is put in the To: field of mail messages along with the full 
address.

You may also type a series of many E-mail addresses (and even other nicknames), separated 
by .i.Commas;commas or .i.Returns:Used for separating addresses;returns, in the .i.Nicknames 
window:Address(es) box;Address(es) section.    These multiple addresses are represented by the 
single entered nickname.    In this way, a nickname can be used for a group .i.Mailing list;mailing
list.
 
 

                                                                Using a nickname as a mailing list

Note:
The Nicknames window is the only place where it is permissible to use a [return] to separate 
addresses.    Everywhere else, you must use commas.

The .i.Nicknames window:Notes box;Notes: field can be used to enter any text you’d like to 
associate with a nickname, such as the addressee’s company, title, or phone number.
 
 



                                                                    Entering notes for a nickname

Note:
The contents of the Notes field is not put in mail you send.

One nickname can point to another nickname, which can point to still another, and so on; 
eventually, however, the nickname must end in a real address or group of addresses.    For 
example, Eudora contains John in its expansion, and John is itself a nickname for 
jnoerenberg@qualcomm.com.
 
 

                                                    One nickname using another nickname

Once you’ve finished typing addresses and notes, you can click the New button again to make 
another nickname.

.i.Nicknames:Saving;When finished making additions or changes, select .i.Save command;Save 
from the File menu to save the changes.    If you close the Nicknames window without saving the
changes, a dialog is displayed asking whether the additions/changes you just made should be 



saved or discarded.
 
 

                                                                        Saving changes to Nicknames

Changing and Removing Nicknames
To change a nickname, select Nicknames from the Special menu.    Click once on the desired 
nickname in the Nickname: field to select it.    Then, click the Rename button.    A dialog is 
displayed allowing you to change the nickname.    You can also add or remove the nickname 
from the .i.Quick Recipient list:Adding existing nickname to;.i.Nicknames:Putting on recipient 
list;Quick Recipient list using the Rename dialog.    Just check or uncheck the Put it on the 
recipient list option.    Once the changes are completed, click OK.
 
 

                                                                                  Renaming a nickname



.i.Nicknames:Changing existing;To change a nickname’s corresponding E-mail address(es) and 
notes, click once on the desired nickname to select it.    The addresses and notes associated with 
the nickname are displayed in the Address(es): and Notes: fields, and may be directly edited.
 
 

                                                                    Changing a nickname expansion

.i.Removing a nickname;.i.Nickname:Removing;To remove the nickname, click once on the 
desired nickname to select it.    Click the Remove button.

.i.Nicknames:Saving;When finished editing or making deletions, select .i.Save command;Save 
from the File menu to save the changes.    If you close the Nicknames window without saving the
changes, a dialog is displayed asking whether the additions/changes/deletions you just made 
should be saved or discarded.

Make Nickname... Command
The .i.Make Nickname... command;Make Nickname... command can be used to make a 
nickname in two different ways.

.i.Make Nickname... command:Using in Nicknames window;From the Nicknames window itself,
use command-click to select several different nicknames, and then choose Make Nickname... 
from the Special menu.    The new nickname dialog is displayed prompting you for the name of 
the new nickname.    Once you have entered the name, click OK to create the new nickname with
the selected nicknames in the Nicknames window as its addressees.    .i.Mailing list;This is an 
easy way to make a group nickname out of existing nicknames.
 
 



                                          Using Make Nickname... to make a mailing list

.i.Make Nickname... command:Using with current messages;Alternately, you can make a 
nickname out of the address list of a current message.    Open a mailbox and single-click on the 
desired message to make it current.    Select Make Nickname... from the Special menu.    The new
nickname dialog is displayed prompting you for the name of the new nickname.    Once you have
entered the name, click OK.    If the current message is an outgoing message, its To:, Cc:, and 
Bcc: fields are used for the nickname’s addressees.    If the current message is an incoming 
message, its From: field is used for the nickname’s addressees.    .i.Mailing list;If multiple 
messages are current (i.e., you have several message summaries selected in a mailbox window), 
addresses are taken from each message and all are put in the new nickname’s expansion.
 
 



                                          Making a nickname from current messages

Note:
When an incoming message is current, Make Nickname... pretends to do a Reply to the 
current message, and then takes all the recipients from the reply message and uses them in 
the nickname expansion.    This means that Make Nickname... acts just like Reply in regard to
the .i.Include yourself option;Reply to all and Include yourself options in the Settings dialog 
(Replying).    That is, if the Reply to all option is turned on (or you hold down the [option] 
key), the nickname is made for all of the recipients of the messages plus the sender, not just
the sender.    Similarly, if the Include yourself option is turned off, your address is not 
included in the new nickname’s expansion.

Using the Nicknames Window to Address Mail
.i.Nicknames window:Using to send mail;.i.Nicknames window:Using to add addressees to 
message;.i.Message:Outgoing:Creating from Nicknames window;.i.Message:Outgoing:Adding 
addressees to with Nicknames window;The To:, CC:, and Bcc: buttons in the Nicknames window
can be used to start mail messages or to add addressees to existing current messages.    To create 
a new message from the Nicknames window, select the nickname to which you want to address 
the mail (you can select multiple nicknames by holding down the [command] key and clicking 
on each nickname).    Then, click the .i.To: button;To: button.    
 
 

                        Starting a new message from the Nicknames window

A new composition window is displayed with the selected nickname(s) inserted the To: field.
 
 



                                        New composition window with addressee

Once the composition window is displayed, use the .i.To: button;To:, .i.Cc: button;Cc: and .i.Bcc:
button;Bcc: buttons to insert additional nicknames into the corresponding fields.

Note:
If you hold down the [option] key when addressing messages using the Nickname window 
To:, Cc:, and Bcc: buttons, the full nickname expansion is inserted into the appropriate 
message field rather than just the nickname.

The Nicknames window can also be used to address existing messages, or new messages created 
by selecting New from the Message menu.    Make sure the desired message is current (topmost), 
then open the Nicknames window and use the To:, Cc: and Bcc: buttons to address the message.

Type-to-Select in the Nicknames window
When the Nicknames window Nickname: field is selected (indicated by the bold square around 
the field), you can type the first few letters of a nickname to select that nickname.    If the bold 
square isn’t around the Nickname: field, click once on the list to select it.
 
 



                                                                          Type-to-select nickname

Nicknames and the Quick Recipient List
.i.Nicknames:vs Quick Recipient list;.i.Quick Recipient list:vs Nicknames;Nicknames and the 
Quick Recipient list are two separate entities.    Nicknames are used as an abbreviation for an 
address or a list of addresses.    The Quick Recipient list is used to add addresses to messages via 
the Message menu.    Nicknames do not need to be on the Quick Recipient list, and not 
everything on the Quick Recipient list needs to be a nickname.

However, you may have nicknames to which you often send mail, and it makes sense to add 
these nicknames to the Quick Recipient list.    This is easily done from the Nicknames window.

Examine the Nickname: field in the Nicknames window.    Notice that there is a margin between 
the first letter of each nickname and the edge of the field.    Now, select a nickname and place the 
mouse over the margin between the nickname and the edge of the field.    The cursor changes into
a miniature image of a .i.Menu cursor;menu.    .i.Quick Recipient list:Adding existing nickname 
to;.i.Nicknames:Putting on recipient list;Click the mouse once and a bullet (.i.•:In Nicknames 
window;•) is displayed in the margin area.    This bullet indicates that the nickname has been 
added to the Quick Recipient list.
 
 

                                      The nickname is now on the Quick Recipient list

.i.Nicknames:Removing from Quick Recipient list;Click again, and the bullet disappears, 
removing the nickname from the Quick Recipient list.    The Quick Recipient list is discussed 
further in the “Using the Quick Recipient List” section.

Note:
Double-clicking a nickname also puts it on or removes it from the Quick Recipient list.



.i.Nicknames:Renaming and Quick Recipient list;.i.Nicknames:Removing and Quick Recipient 
list;If you rename or remove a nickname that is also on the Quick Recipient list, the name on the 
Quick Recipient list is also changed or removed.

Finish Nickname Command
.i.Finish Nickname command;The Finish Nickname command under the Edit menu is another 
nickname-related function designed to save typing in header fields.    It allows you to type only a 
portion of a nickname in the To:, Cc:, or Bcc: fields of a message, with Eudora completing the 
typing task. 

To use this option, type only the number of characters in the nickname that make it unique with 
respect to other nicknames in the appropriate field of the message header.    Then, select Finish 
Nickname from the Edit menu.    The partial text of the nickname is automatically completed in 
the header field.

For example, if you type an “S” in the To: field and you only have one nickname that starts with 
the letter S, the Finish Nickname function completes the nickname in the message header.

Note:
If you hold down the [option] key while finishing a nickname, the nickname’s .i.Finish 
Nickname command:Inserting expansion instead;expansion is inserted instead of the 
nickname itself.
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